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Preface 
 

This Quick Start Guide provides a fast and friendly introduction on FINE4Rate main 
features and functionalities.  

FINE4Rate is the BIM Solution for the NATHERS Thermal Comfort Modelling, which 
provides advanced modelling capabilities in an easy to use BIM interface, combining the 
AutoCAD functionality with the DWG & IFC full compatibility. The program uses its 3D BIM 
interface to provide the NATHERS Energy Accessor the capability to automatically 
populate all building and zone data straight from the 3D model into the data entry fields of 
Accurate Sustainability. The friendly BIM interface of FINE4Rate allows the assessor to 
spend time, a fraction of the otherwise required, to thermally engineer dwellings rather 
than spending it on endless hours of data entry. 
 
FINE4Rate is the only BIM Powered Software that provides the Energy Accessor with a 
true 2D-3D drawing environment that is using DWG as its native file format. The assessor 
can import IFC files of the building 3D model produced by the building designer directly 
into the traditional Accurate Sustainability fields. FINE4Rate includes also all the CAD 
features of 4MCAD, a fully functional 2D/3D CAD software which is also known as the 
smart alternative to AutoCAD. 
 

Despite its numerous capabilities, FINE4Rate has been designed in order to be very easy to 
learn. This quick guide is divided into three short parts: 

- Part 1 describes the installation procedure and the main menu structure. 
- Part 2 deals with the BIM interface of FINE4Rate, showing its philosophy and main 

features. 
- Part 3 shows an example which makes clear the whole process. 
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1. Installation - Launching 
 

1.1 Installing FINE4Rate 

 
1. Insert the CD in your computer CD-ROM drive (e.g. D:, E:) or, if you received your 

software via Internet, run the installation application you downloaded. 

2. When the Setup window appears, choose the language for the installation and click 
OK. 

3. When the Welcome page appears (as shown below), click Next. 

 

4. When the License Agreement appears, read it carefully. If you agree with the terms, 
check the respective “radio button” and then click Next (you must agree with the terms 
to proceed with the installation). 

5. In the next screen enter your username and organization information and check if you 
want to create a desktop icon. Then click Next to see if the information is correct (see 
the following window) and finally click Install for the installation procedure to begin. 

6. Then the program will ask you to select the folder <AccuRateSustainability> where the 
AccuRate Libraries are located. 

7. Upon completion of the installation procedure, the following last window appears on 
screen and all needed is to click Finish. In case that the Run FINE4Rate checkbox is 
selected, the program will start running. 
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8. After installation, the program is located within the programs list. 
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2. CAD Component 
 

2.1 Overview 
FINE4Rate is a powerful BIM workstation which produces the XML file directly from the 
building model. This first Part (Part I) of the user's guide describes the operation of the 
BIM interface of FINE4Rate. This BIM interface considers the building as being composed 
of intelligent entities with their own attributes and properly related each one to each other.  

2.2 Main menu  
As soon as the program is loaded, the main menu screen appears for the first time: 

 

Among the commands of the designing environment, we notice the following main options 
of the package: 

1. Project files management options (New Project, Open Project and Project Information) 
which are located into the options group FILE. 
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2. Option Group with the name AutoBLD, which includes all the commands required for 
the building design. 

3. Auxiliary option group with the name PLUS, which contains a series of designing 
facilities for the user. 

Starting with FINE4Rate, you define a 
new project through the corresponding 
option in the FILE menu mentioned 
above. In case that "New project" is 
selected, a window appears on the 
screen where the name of the Project 
should be typed. 

In order to "load" an existing project, 
which has been created with the program 
and you want to further edit it or just view 
it, you select "Select Project", and a list 
with the existing projects in the hard drive 
will be displayed on the screen. At first, 
the list displays all the projects that exist 
in the FINE4Rate directory and with the 
use of the mouse or the keyboard and 
acting correspondingly, you can transfer 
to any other directory, viewing at the 
same time the existing projects. It is 
noted that the projects are included into 
directories with the extension BLD. If an 
existing project is selected, it is loaded 
and displayed on the screen. 

Either if a new project is created or a saved one is loaded, you can start working with the 
use of the subsystem commands described above. A detailed description of these 
commands is available in the following chapters. Before this detailed description, a short 
reference of the basic designing principles featured in the designing environment of the 
package is recommended, in chapter 2.3 that follows next. If you are familiar with the use 
of 4MCAD or AutoCAD, you may page through or even skip this chapter, while if you are 
not, you should read it carefully. 

2.3 Drawing Principles & Basic Commands 

A great advantage of the package is that the structure and the features of the drawing 
environment follow the standards of the CAD industry adopted by AutoCAD, 4MCAD etc. 
In particular, the available working space is as follows: 



 
 

 
FINE4Rate  - 5- 

 

As shown in the above figure, the screen is divided into the following "areas": 

 Command line: The command line is the area where commands are entered and the 
command messages appear. 

 Graphics area: The largest area of the screen, where drawings are created and 
edited. 

 Cursor: The cursor is used for drawing, selecting objects and running commands from 
the menus or the dialog boxes. Depending on the current command or action, the 
cursor may appear as a graphics cursor (crosshairs), a selection box, a graphics cursor 
with a selection box etc. 

 Pull-down menus: Each time you select one of these commands (AutoBLD, AutoNET 
etc.) a pull-down menu is shown. 

 Status Line: It is the line on the bottom of the screen where the current level, the 
drawing status and the current cursor coordinates are displayed. From the status line 
you can enable or disable tools such as SNAP, GRID, ORTHO etc., which are 
explained in the following chapter. 

 Toolbars: You can arrange which toolbars you want to be shown in the screen in each 
project. To enable or disable a toolbar, in the upper part of the screen (where the 
existing toolbars are shown) right click with the mouse and select the desired toolbar 
from the list (as it is shown below). 
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Apart from that, each time you select an application from the AutoNET menu, a toolbar 
with the name of the application is shown and you can either work from there or from 
the AutoNET commands.   

2.3.1 Drawing aids 

This section describes the most important drawing aids. These are the commands: 

SNAP: The graphics cursor position coordinates appear in the middle of the upper part of 
the graphics area. If "Snap" is selected, the graphics cursor movement may not be 
continuous but follow a specific increment (minimum movement distance). To change the 
increment, right click with the mouse on “SNAP” and choose “Settings”. To activate or 
deactivate it, double click on the “SNAP” icon. 

GRID: The screen grid is a pattern of vertical and horizontal dots, which are placed at the 
axes intersection points of an imaginary grid. The grid can be activated or deactivated by 
clicking the corresponding icon or by pressing F7.  

ORTHO: The "Ortho" feature restricts the cursor to horizontal or vertical movement. The 
status bar shows whether the "Ortho" command is activated by displaying "ORTHO" in 
black characters. The command is activated or deactivated by clicking the corresponding 
icon or by pressing F8. 

ESNAP: The "Esnap" command forces the cursor to select a snap point of an object, 
which is within the Pick box outline. The esnap points are characteristic geometric points 
of an object (i.e. endpoint of a line). If you have specified a snap point and move the 
cursor close to it, the program will identify it with a frame. The "Esnap" command can be 
activated either by holding down the "SHIFT" key and right clicking the mouse or through 
the additional toolbar. 

2.3.2 Drawing Coordinates 

When you need to determine a point, you can either use the mouse (by seeing the 
coordinates in the status bar or using the snap utilities), or enter the coordinates directly in 
the command line. Moreover, you can use either Cartesian or polar coordinates and 
absolute or relative values, in each method (relative coordinates are usually more 
convenient). 

Relative coordinates: Enter the @ symbol (which indicates relative coordinates) and 
then the x, y, z coordinates (Cartesian system) or the r<θ<φ coordinates (polar system) in 
the command line. The system used (Cartesian or polar) is defined by the “,” or “<” symbol 
respectively. If you do not insert a value for z or φ, it will be automatically taken as zero. 
For example, if you are prompted to locate the second (right) endpoint of a 2m horizontal 
line, you enter: 

@2,0 if you use the Cartesian coordinates (which means that the distance of the second 
point from the first is 2 m on the x axis and 0 m on the y axis), or 

@2<0 if you use the polar coordinates [which means that the second point is at a distance 
of 2m (r=2) and an angle of 0 degrees (θ=0) from the first]. 

Absolute coordinates: They are specified in the same way as the relative coordinates 
but without using the @ symbol. The absolute coordinates are specified in relation to the 
0,0 point of the drawing. 

The measurement system can be activated, deactivated or changed with the F6 key. 
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2.3.3 Drawing Basic Entities 

In the “Draw” menu you will find the basic drawing entities: 

Line: "Line" option is used for drawing segments. When you select "Line" from the menu 
or type "Line" in the command line, you will be prompted to specify a start point (by left 
clicking or by entering the point coordinates – relative or absolute – in the command line) 
and an endpoint (determined in the same way). 

Arc: The "Arc" command is used for drawing arcs. An arc can be drawn in different ways: 
the default method is to specify three points of the arc ("3-Points"). Alternatively, you can 
specify the start point and endpoint of the arc as well as the center of the circle where it 
belongs (St, C, End). You will not find it difficult to understand and become familiar with 
the various methods of drawing an arc. 

Polyline: This command allows you to draw polylines, which are connected sequences of 
line or arc segments created as single objects. The command is executed by either using 
the menu or typing "pline" in the command line. You will be prompted to specify a start 
point and an endpoint (by right clicking the mouse or by entering the point coordinates – 
relative or absolute – in the command line). Then, the command options will appear (Arc, 
Close, Length etc). Select A to switch to Arc mode, L to return to Line mode and C to 
close the polyline. 

2.3.4 Useful Commands 

This section includes brief descriptions of the basic program commands, which will be 
very useful. These are the commands "Zoom", "Pan", "Select", "Move", "Copy" and 
"Erase" (you will find them in “View” and “Modify” menus). In particular: 

Zoom: "Zoom" increases or decreases the apparent size of the image displayed, allowing 
you to have a "closer" or "further" view of the drawing. There are different zooming 
methods, the most functional of which is the real-time zooming ("lens / ±" button). You can 
use the mouse to zoom in real time – that is to zoom in and out by moving the cursor. 
There are a number of zoom options as shown by typing "Zoom" in the command line: 
All/Center/Dynamic/Extents/Left/Previous/Vmax/window/<Scale(X/XP)>. 

Pan: "Pan" ("hand" icon) moves the position of the visible part of the drawing, so that you 
can view a new (previously not visible) part. The visible part of the screen moves towards 
the desired area and to the desired extent. 

Select: This command selects one or more objects (or the whole drawing), in order to 
execute a specific task (erase, copy etc.). Select is also used by other CAD commands 
(for example, if you use the "Erase" command, "Select" will be automatically activated in 
order to select the area that will be erased).  

Move: This command allows moving of objects from one location to another. When the 
"Move" command is activated, the "Select" command is also activated so that the object(s) 
you want to move (in the way described in the previous paragraph) can be selected. 

After you have selected the desired object(s), you are prompted to specify the base point 
(using the snap options), which is a fixed point of the drawing. When you are prompted to 
specify the position where the base point will be moved, use either the mouse or the snap 
options. After you have completed this procedure, the selected object(s) will move to the 
new position. Please note that the base and the new location points can be also specified 
with the use of coordinates (absolute or relative, see related paragraph). 

Copy: The "Copy" option allows the copying of objects from one location to another. The 
"Copy" procedure is similar to the "Move" procedure and the only difference is that the 
copied object remains at its original location in the drawing. 
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Erase: Choose this option to delete objects. The procedure is simple: Select the objects 
you wish to erase (as described above), type "E" in the command line and press <Enter>. 
Alternatively, you may first type "E" in the command line, then select the object(s) by left 
clicking and finally right click to erase the object(s). 

DDInsert (Insert Drawing): This command allows you to insert another drawing (DWG 
file) or block in the drawing. When this command is selected, a window appears in which 
you select block or file and then select the corresponding block or file from disk. Then you 
are prompted to specify the insertion point, the scale factor etc., so that the selected 
drawing is properly inserted. 

Wblock: The "Wblock" command allows us to save part of a drawing or the entire drawing 
in a file, as a block. When this command is selected, you are prompted to enter the file 
name and then you select the drawing or the part of the drawing you wish to save. The 
use of this command is similar to the "Screen Drawing" command in the AutoBLD menu, 
which will be described in a following section. In order to insert a block in a drawing, you 
use the "ddinsert" command described above. 

Explode: The "Explode" command converts a block in a number of simple lines so that 
you can edit it in that form. If it is selected, the program will prompt you to select the block 
("Select object") you wish to explode. 

2.3.5 Grips 

Grips are some characteristic points of an object, which appear after it is selected (by 
moving the cursor on the object and left clicking). The object is displayed with grips (small 
squares in blue colour), which mark control locations and are powerful editing tools (by 
selecting one grip you can for example, move or change the length of the line). When you 
click a grip, the following 
prompt appears in the 
command line: 
**STRETCH** <stretch to 
point> /Base point /copy/ 
undo/ exit. If you press 
<Enter> (or right click), the 
first characters of the 
corresponding word are 
entered, e.g. “sc and enter” 
for the "Scale" command). 

When a command is 
executed, grips disappear 
and the objects are 
deselected. If the 
command is an editing command (correction or copy), which can be preselected, the 
objects take part in the execution of the command automatically. In this case, the 
command overrides the "Select objects" prompt and proceeds. To deselect grips and 
objects you should press <Esc> twice: once to deselect the objects and twice to 
deactivate the grips. 

In each object the positions of the grips are different. Namely, for a point the grip is the 
point itself, for a segment the grips are the midpoint and the two endpoints, for an arc the 
midpoint and the two endpoints, for a circle the center and the quadrants, for a polyline 
the endpoints of the line and arc segments and the midpoints points of the arc segments, 
for a spline the spline points, for a block the insertion point, for text the insertion point etc. 
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2.3.6 Print 

This section may be read after you have created a drawing and you want to print it. Any 
drawing can be printed using a printer or plotter or to a file. Printing is performed using 
"PLOT" command, selected either from the "FILE" menu or typing it in the command line, 
provided there is a drawing already loaded.  

Viewing a drawing before printing gives you a preview of what your drawing will look like 
when it is printed. This helps you see if there are any changes you want to make before 
actually printing the drawing. 

If you are using print style tables, the preview shows how your drawing will print with the 
assigned print styles. For example, the preview may display different colours or line 
weights than those used in the drawing because of assigned print styles. 

To preview a drawing before printing 

1. If necessary, click the desired Layout tab or the Model tab.  

2. Do one of the following:  

 Choose File > Plot Preview.  

 On the Standard toolbar, click the Plot Preview tool .  

 Type ppreview and then press Enter.  

3. After checking the preview image, do one of the following:  

 To print the drawing, click Plot to display the Print dialog box.  

 To return to the drawing, click Close. 

The Plot dialog box is organized in several areas as it is shown in the picture below. For 
help defining print settings before you print, see Customizing print options. 

In the plot window, you can select the printer, the paper size and the number of copies 
and several plot options such as the style (pen assignments), the orientation etc. 

Moreover, you can select the plot scale and the plot area. Before you proceed to printing, 
you select “Apply to layout” and then “Preview” so as to make any modifications you might 
want. 

To print a drawing 

1. If necessary, click the desired Layout tab or the Model tab.  

2. Do one of the following:  

 Choose File > Plot.  

 On the Standard toolbar, click the Print tool ( ). If you click the Print tool, the Print 
dialog box does not display. Your drawing will be sent directly to the selected printer.  

 Type print and then press Enter.  

3. From the Plot dialog box, make any adjustments to the settings.  

4. Click OK.  
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2.3.7 Plus Drawing Tools 

Those tools belong to the large group of options under the general menu PLUS. These 
are a series of additional drawing tools, which have been embodied in the package in 
order to help the user during drawing. 
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2.4 AutoBUILD: Building Design  
The AutoBLD group of commands, includes all the facilities required to insert/define a 
building following a BIM philosophy. As it is shown below, the various options/commands 
are divided into sub-groups. 

 

In general, the first sub-group includes commands for the definition of the project 
parameters, the second and the third sub-group includes drawing commands, the fourth 
sub-group includes commands for linking to the calculations, and the fifth sub-group 
includes management options for the AutoBLD libraries and commands for the building 
supervision. In the following sections, the options reported above are described one by 
one, starting from the "Building Definition" option. 

2.4.1 Building Definition 
and Layers Management 

As soon as you select the 
"Building Definition" command, 
the levels management menu 
appears. 

On this screen the levels of the 
project building are defined, which 
means that you have to determine 
the level and the corresponding 
architectural drawing (plan view-as 
xref) (DWG file) of each building 
floor (only in case you use a 
drawing that was created by 
another architectural designing 
program). More specifically: 
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 In the "Level" field, define the level (floor) number (always starting with the number 
“1”). 

 In the "Elevation" field, define the height of the floor level. You can define manually a 
benchmark for level measurement (e.g. the pavement).  You can also define negative 
levels (e.g. -3 m for the basement). 

 In the “Name” field, you give a name for each level. 

 In the "File" field, define the path and the name of the relevant DWG drawing-file, only 
if you refer to an already existing drawing (which means that you do not intend to draw 
the plan view from scratch). If there is no DWG architectural drawing available, leave 
this field empty.  

The insertion and the management of plan views are performed with use of the xref 
command. At the bottom of the dialog box there are three functions available which are 
used to manage the level files. Specifically: 

 Press the “New” button to save a new level or save the changes in the data of a level 
(e.g. elevation, DWG drawing).  

 Use the "Current" option to select the plan view/file you want to work on each time. 

 Select the "Delete" option to 
delete the level you want (after 
you have it selected). The 
"Delete" command removes the 
plan view of the relevant level 
in the project without deleting 
the original architectural DWG 
file.  

 The “Accept” command closes 
the dialog box (it does not save 
the floor data. This can be 
managed with the “New” 
command). FINE4Rate enables 
also the use of a “scanned” 
ground plan, which is a ground 
plan in a bitmap file created by 
a scanner. 

The “Layers Management” option gives you the choice to enable or disable in a quick 
and practical way (during working) several layers. If you want, you can disable any 
element group by simply clicking inside the indicator-box of the corresponding group. 
When the box is checked, the corresponding group is enabled.  

2.4.2 Constructions 

As shown below, this command leads to the basic building envelope elements 
(Walls, Openings and Floors/Ceilings) where the user has to define the 
constructions (material libraries) to be used for the specific project by selecting 
properly the respective items out of the AccuRate material libraries. 
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For example, by selecting “Openings” the following window with an empty list of types of 
Openings (for both Windows and Doors) appears on screen: 

 

 

 

The user has to press the “Library” button at the bottom to select the appropriate 
materials. 
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By double clicking on an item, the respective material is transferred from the AccuRate 
libraries to the project Openings. 

 

Same is the procedure concerning the walls and the other elements. 

Through this process, the user prepares the construction libraries for the specific project 
he/she is working on. 
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2.4.3 Element Parameters 

Through this command, the user can define the default values for each element type 
concerning the specific project. In particular, these values will serve as default values for 
the drawing commands which are described in the next paragraph. The user can skip this 
step since he/she can also define those values directly within the dialog boxes of the 
drawing commands themselves. 

 

2.4.4 Drawing Walls 

AutoBLD menu contains all the commands required for drawing and editing walls, such as 
parallel moving of walls, trimming, extending, joining and breaking walls as well as placing 
openings of any kind on them (windows, sliding doors, openings, arches). During the initial 
drawing, as well as during any modification at any stage, the drawing is automatically 
updated (e.g. placing an opening on a wall does not break the wall in two parts, the 
opening moves easily from side to side whether you are working on the ground-plan or on 
a 3D view and the wall is restored without leaving undesirable lines after deleting an 
opening etc.).   

The Wall option, located at the second 
subgroup of the AutoBLD group of 
commands, includes the External, 
Internal, External wall from polyline, 
Internal wall from polyline and Outline 
options as well as the option subgroup 
Modify, Delete, Extend, Break, Join, 
Trim and Move. The first subgroup 
concerns the wall drawing, while the 
second their further processing after 
being drawn. By selecting External Wall, 
first of all its attribute dialog appears 
with a series of parameters (type, 
dimensions, colours etc.).  
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In order to start drawing a wall, you click OK and then follow the instructions shown below: 

External wall (straight / arc): After activating the command (by pressing <Enter> in the 
menu), you are required to successively provide: 

i) the starting point of the wall (the application message in the command prompt is: ‘’Wall 
start \ Relative to wall \ Toggle shape <Linear>’’) 

ii) the ending point of the wall (the application message in the command prompt is ‘’Wall 
end \ Relative to wall \ Toggle shape <Linear>’’) 

iii) the direction towards which the wall shall grow, by providing any point on one of the 
two half-planes defined by the wall line (the application message in the command prompt 
is "Enter Side Point"). 

 

After the above actions, you can see that the wall has been drawn and that you can 
continue to draw another wall starting from the ending point you defined earlier, unless 
you right click, which means that you want to stop (or press “ENTER”). You can change 
the wall drawing from linear into circular, typing T in the following program prompts and 
pressing <Enter>. During drawing, one can come to the conclusion that the ability of 
drawing consecutive walls is very convenient since it prevents you from making many 
movements. As mentioned further below, in the “Element Parameters” section, the 
thickness of the wall, its height and its level in relation to the floor level (when the level is 
0, the wall starts from the floor), are stored within the “Element Parameters” for the wall. 
By providing proper values for the 
wall height and level, any possible 
case of walls of unequal height 
can be dealt with. 

Further to the drawing functions, 
the program also provides 
powerful editing tools, such as 
erase, modify (through the wall 
dialog box), multiple change etc. 
Two other commands that are 
widely used while drawing the 
walls are a) the Undo command, 
which enables you to reverse the 
previous command executed and 
b) the Properties command, which 
enables you to view (and change) 
the attributes of the selected wall.  
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2.4.5 Drawing Openings 

Once the command "Opening" is activated, a second option menu is displayed, including 
a variety of opening types (window, sliding door, door etc) to draw, plus also a set of 
editing functions such as "Erase", "Modify" or "Move", applied to existing openings. 
Besides, at the bottom of this menu lies the option “Libraries”, which enables the user to 
define his/her own opening freely, to create various shapes of windows. 

Window: The option "Window" demands that you select the wall on which the opening will 
be placed and then define the beginning and the end of the opening (all these actions are 
carried out using the mouse and pressing <Enter> each time). The window will 
automatically obtain the data that are predefined in the “Attributes”, namely the 
corresponding values for the height, the rise, the coefficient k etc). Of course, you can 
draw the window from the ground plan as well as in the three-dimensional (3D) view.  
During drawing a window, it is very helpful to the user the fact that, after the wall where 
the window will be automatically placed is selected, the distance from the wall edge is 
displayed in the coordinates position on the top of the screen, while the crosshair is 
transferred parallel to the wall for supervision reasons. The measurement starting point 
(distance 0) as well as the side (internal or external) are defined by which one of the two 
edges is closer and which side was "grabbed" during the wall selection. Similar 
functionality exists for other types of openings, such as Sliding Doors, Doors, Openings 
etc.  

2.4.6 Columns 

The insertion of a column is made through the Column -> Placement command which 
activates the following dialog: 

 

The user has to select the type of Column and then to define its geometry through its 
shape (Orthogonal or Circular) and dimensions. 

The Column is an object that can be moved, copied, erased etc. It is also editable through 
the command Column -> Modify. 
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2.4.7 Floors – Ceilings – Roofs 

 
I. Floors – Ceilings 

 

This group of commands includes the drawing and modification of Floors, Roofs and 
Ceilings as well as Floor and Ceiling Opening areas. First of all, a Floor or a Ceiling is 
defined by its type with respect to the ground/space it is in contact with (for example a 
“floor to the ground” or a “floor to the interior” etc) and its construction. 

 

By clicking on the “Type” (Construction) button, the user can select the respective Floor 
material.   

 

 

To draw a floor or a ceiling the user has either to select a polyline or to enter the points in 
order to define the surface of the floor or ceiling. 
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II. Roofs 
 

In the case of defining a Roof, there are two options, A flat roof were the user selects its 
construction (similar to floors and ceilings), or an inclined Roof, were the user selects 
among a set of types of roofs and then also selects its construction. 

 

The definition and/or editing of a Roof is performed through the appropriate dialog (like the 
one below for the “Four-sided Roof”). 

 

2.4.8 Viewing Commands 

 

The Building model of a FINE4Rate project can be viewed through the following 
commands: 

 Plan View (2D): The two-dimensional plan view of the respective building level is 
shown. 
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 3D View: A three-dimensional supervision of the ground plan of the current floor (with 
given viewing angles) is shown.  

 

 Axonometric: Provides three-dimensional supervision of the whole building (for all 
floors), with the given viewing angles as they have been selected in "Viewing 
Features". 
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2.4.9 Definition of Plan View Elements  

The FINE4Rate building model includes intelligent information, capable to recognize 
Zones and Dwellings.  

 

 

More specifically, as far as a “Zone” is considered, the “zone definition” command enables 
the user to define one or more zones, in two alternative ways:  
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a) by selecting the walls that surround each zone, or  

b) by defining an internal and an external point of the zone. This way needs only the 
definition of an internal point of the zone (by 
a left click of the mouse) and an external 
point so that the line-rubber that is formed 
intersects a zone wall. Then the program 
"indicates" (by discontinuous outline) the 
defined zone and asks for the zone name in 
the command line.  

By entering the name, the zone definition is 
completed and its features are indicated on the drawing. Given that one or more zones 
are already defined,  

 

As soon as the zone is defined, its name and surface (in m2) is shown at the centre of the 
zone. 

 

 

Regarding Dwellings, they can be defined only through Walls. 
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2.4.10 Shades 

FINE4Rate provides the user with special tools to figure out the shades, due to various 
causes (neighbour buildings, horizontal and vertical cantilevers/slabs etc). 

 

 

For instance, a neighbour building can be defined easily through a few simple steps: 

The program asks the user to click on the polyline which corresponds to the ground plan 
outline of the building, or alternatively to click successively on the points of this outline. 
Whatever is the case, the program asks then for the building elevation (ground level) and 
thereafter for the building height and blocking factor. As a result, the neighbour building 
appears on the screen in 2D and 3D. 
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The building outline as well as the values for the building height are always editable 
through the respective commands. 

After the neighbour building definition, the building walls and openings have to be 
attached to the neighbour building through the command “Attach/Detach”. 

 

This command asks first the user to “Select the Neighbour Building” and just after the 
expected click, the user is asked to select between Attach or Detach. 

 

If the command “Attach” is the case, then the program asks the user to show the adjacent 
entity to be attached with (i.e. wall) and after the selection, the user has to press <Enter> 
and thereafter to  “Select a point on the neighbour building frame” for the attachment info 
to be visible though a line (lines) along with its distance(s). 
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While executing the Attach command, the user can keep selecting more than one objects 
(i.e. separately the wall and windows) the program showing at the same time the number 
of “entities in set”. 

The Detach command is quite similar, the user has to select the entities and then to press 
enter. As a result, the attachment lines disappear. 

The same concept is being used for the other commands as well, regarding the horizontal 
and vertical cantilevers and/or slabs: the program asks the user to click on the respective 
polyline or alternatively on the successive points and thereafter the program asks for the 
elevation and thickness values as well as the blocking factor in order to create the object 
through which the shade will be finally calculated. 

2.4.11 Creation of the Accurate XML file 

Once the user has defined 
properly all the zones, he/she can 
apply the command “AccuRate 
XML Creation” in order to create 
the XML file which constitutes the 
input file to AccuRate program. 
Given that all the necessary 
building elements have been 
defined in the 3D model along 
with all the additional necessary 
info (zones, vertical shades, horizontal shades etc), therefore as a result, all this info can 
be exported to the AccuRate Sustainability project file. 
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3. Example 
 

In this chapter an example is presented, which will help you understand in practice the 
basics of drawing in FINE4Rate. This simple example aim mainly at helping you start 
drawing building entities (walls, openings etc) and defining the necessary elements so all 
data is populated to the Accurate Sustainability software. 

Apart from the following example, you can watch the same steps (and much more) in the 
videos you will find in https://www.youtube.com/channel/UCcUvAionkYxaC9TZFP2C4Fg 

 

Very important: We draw in meters (with three decimal places to be compatible in 
view with most plans that show lengths in mm), so if plans are in mm we have to 
scale every each one by 0.001 

 

We will explore two different options, the existence of an IFC file, that is the 3D model of 
the building which every updated architectural software has the capability to produce, and 
the option of having simple plan drawings files in dwg or dxf format. There is also the 
option of having pdf files but this is not recommended since there are really not easy to 
work with in a drafting environment. 

Let us assume for example that we have a 2-storey building with separate dwellings in 
each floor. The plans of each floor are given in the following images 

 

Ground Floor 

 

 

https://www.youtube.com/channel/UCcUvAionkYxaC9TZFP2C4Fg
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First Floor 

 

3.1 Building definition 
In all cases the first step is to define a new project 

 

We select our main projects folder and then we assign in the dialogue box the name for 
our project, say DEMO01. The software then creates inside the main projects folder a new 
folder named DEMO01.BLD which will be our project folder and inside this folder it also 
creates the file DEMO01.dwg our working project dwg file. 

Then we provide all project information such as Project name, Project code, Building 
class, Dwelling address, Assessor details, client details Plan Document details 
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All the information will be exported and populate the same fields in the respective 
AccuRate Sustainability file  

 

 

Then we have to select the constructions for all building elements, that is External Walls, 
Internal Walls, Floors/Ceilings, Roofs, Windows etc 

We use the AutoBLD – Constructions menu 

There are already selected constructions for every element but of course we can also 
select other constructions from the AccuRate database 
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3.1.1 IFC importing 

After defining and creating our project file and having selected our Constructions database 
we use the IFC import command to import the 3D model of the building. We select the ifc 
file and click open 

 

We click to select the Building elements option, then OK 

 

After importing the 3D model we are prompted to Pair all structural elements with our 
Constructions database 

 

 

Having done that we get the whole building with all its building elements been assigned 
with the selected Constructions 
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Of course if we need to change the construction of a single or multiple elements we can 
do so, for example we like to change the wall construction of all first floor walls. 

We click the Plan View icon, click the One Level Up or One Level down icon to select the 
working level, use the AutoBLD-Wall-Multiple Modification pull down menu command, 
select all external Walls, click enter and the Modify Walls dialogue box appears.  

 

We select Type, choose the preferred Construction and click accept and accept. All 
selected walls are now of the Brick Veneer R2.0 Construction type 

 

Same applies to internal Walls  
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3.1.2 DWG or DXF plan files 

In the case that we are provided with dxf files we simply open them and save them as dwg 

After defining and creating our project file and having selected our Constructions database 
next step is to define the Building Levels and assign the appropriate dwg file 

We use the AutoBLD – Building definition pull down menu command 

Then for each level we have to provide  

The Level number, its elevation (in meters), a name (not required), select the appropriate 
dwg file by clicking File and choosing it and New 

 

Then we lock the xref (plan dwg) layers by using the Layers Explorer so that we don’t 
accidentally erase or move them. These layers have the name BASE_FL001_XREF, 
BASE_FL002_XREF etc 

 



 
 

- 32 -  FINE4Rate 

In the case of dwg plans we have to actually draw all necessary building elements, these 
are External Walls, Internal Walls, Windows and Doors, Roofs if they are inclined and of 
course assign to each one of them the appropriate Construction (chapters 2.4.4 to 2.4.7) 

3.2 Dwellings and Zones definition 
This Building has 2 Dwellings and a total of 7 Zones 

Dwellings definition: AutoBLD – Element Parameters – Dwellings… pull down menu 

 

In this dialogue box we fill the vertical and horizontal maximum internal dimensions that 
give the footprint of each dwelling, this info will fill the appropriate fields in the ventilation 
dialogue box in AccuRate Sustainability. We also select whether to export the dwelling to 
an xml file or not.  

Zones definition: AutoBLD – Element Parameters – Zones… pull down menu 

Define number of Zones, and then for each Zone the Name, Type, Penetrations and 
Vertical offset (in case of a zone being in an elevated height on the same level) 
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Assign zones for each space 

Using the Zone Definition by point icon or the menu command AutoBLD-Definition of Plan 
View Elements-Define Zone by point, we click inside the zone and click towards a wall, 
the zone selection dialogue box appears and we select the Zone 

 

3.3 Floors - Ceilings - Roofs 
Using the Floor – Ceiling icon we define floors and ceilings as well as opening areas in 
floors or ceilings 

We don’t need to follow the zones, we define the areas that each element occupies 

For the ground floor for example we have two different Floor Constructions: 

F2 to ground:  Concrete Slab 200mm: ceramic tiles/bare for BATH and  

F3 to ground:  Concrete Slab 200mm: carpet/bare for KLD and BED 
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Same applies to First Floor and Ceilings 

For flat Roofs also 

 

In our example we define the Roof construction on the second Level (First Floor) 

R1: Concrete Roof – pebbles/plasterboard R2.5 

 

 

In case there is an inclined Roof, then we have to define it by using the Roof Placement 
icon. The software is capable of not only defining the single type Roofs found in AccuRate 
Sustainability software (single sided=Single slope, Double sided=Hip, Four sided=Gable) 
but also more complicated Roofs as isoclinal and anisoclinal. After defining their geometry 
we have also to assign a roof construction 
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3.4 Shades 

3.4.1 Horizontal Schemes 

Using the Horizontal shading Scheme Slab icon we first define the slab by either drawing 
its perimeter or selecting a rectangle that defines it and input its characteristics that is 
elevation and blocking factor 
To define the walls or openings that the scheme applies to we double-click to a point in 
the perimeter of the scheme, choose attach and then click to a point of the appropriate 
walls and openings. We are permitted to define only two Horizontal Schemes per wall, 
one per opening 

 

3.4.2 Vertical schemes 

Using the Vertical shading Scheme icon we first define the neighbour Building or Screen 
by either drawing its perimeter or selecting a rectangle that defines it and input its 
characteristics that is elevation, height and blocking factor 
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To define the walls that the scheme applies to, we double-click to a point in the perimeter 
of the scheme, choose attach and then click to a point on the appropriate walls. We are 
permitted to define only three Vertical schemes per wall. 
We can also define as a vertical shading scheme a wall that shades another, that would 
also be the case of a balcony wall. We do so by using the furthest to the right icon, 
“Attach/Detach Walls or Openings to vertical scheme”, click at the vertical scheme wall, 
give its height at the prompt and then click the wall that it shades.  

3.4.3 Wing Walls 

Using the Wing Wall shade icon we first choose whether we like the shading area to be 
hatched or not, we define that by clicking in the Draw box and Accept, then by clicking to a 
point that defines the Wing Wall furthest point, input the vertical offset value and select the 
appropriate wall. We are permitted to define only one Wing Wall per side of a given wall  

 

 

To define different blocking factors per month to a scheme we click the Blocking Factors 
Modify icon, then select by clicking the appropriate Horizontal or Vertical scheme and 
input the required values for each month 

3.5 Creation of the Accurate XML files 
We use the AutoBLD - AccuRate 
XML creation pull down menu 
command and the software 
creates the two XML files each 
for every dwelling which 
constitute the input files to  the 
AccuRate Sustainability sofware.  

 


